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1 Netop Live Guide 

The Netop Live Guide operator console is your interface to manage contacts from 

customers who click a button on your company Web site because they want to get in 

touch with a company representative for information or for assistance. 

Each customer contact session is logged, for example with information about call 

duration, campaign and department, to enable you to subsequently do statistics 

based on the historical data. 

The information displayed in the customer calls list can be customized as can the use 

of colors and the use of audio for various types of alerts. 

The three main sections below describe how to manage calls, how to use historical 

data and how to customize the operator console interface to match your preferences. 

The first section, though, briefly describes the logon procedure. 

2 Log on to Netop Live Guide operator console 

For your initial log on to Netop Live Guide operator console, you will receive an email 

with a link to the operator console as well as a password to be used for your first 

logon.  

When you click the link you are 

presented with a launch screen and 

then a logon screen where you must 

type your email address and the 

password from the email. 

When you have logged on to the 

operator console, you should change 

your password. 

Password rules: 

 The password cannot be the same 

as your email. 

 The password must be at least 6 

characters long. 

 The password must include at least 

one upper case letter and one digit. 

 

You are automatically asked to change your password when you log on for the first 

time. 

See section 5.1 for information about changing password, other than on first logon. 
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3 Manage calls 

When you are logged on and ready to received customer calls you see a window like 

this: 

 

Incoming calls that have not yet been answered are listed on the Queue tab; the 

first call in the list (from the top) is the customer who has been in queue the longest. 

To answer the call from the customer who has been in the queue the longest, click 

the Take next button, or you can double-click a customer information line in the 

queue list. You can now begin chatting with the customer in the chat area.  

The chat area also displays overview information about the customer, for example 

the customer’s location. To see more customer information click the triangle icon  at 

the top of the chat area.  

  

During the chat, you can choose to turn on your audio 

and your video from the Operator menu. 

And you can choose whether you want this to be for 

the current customer only or whether audio or video 

should be for all customers. 

 

From the Customer menu you can choose to let the 

customer use his or her audio and video. 
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A number of tools are available to assist you during the chat; the tools are available 

from separate tabs on the Tools tab.  

3.1 Queue 

The Queue list is the area where customer calls come in and remain until you or one 

of the other operators answers them: 

 

The All Customers list displays all customers who are currently either chatting with 

an operator or waiting for their call to be picked up. 

The Queue list, the All Customers list, and the All list have the same types of 

information: 

Type This can be “Customer” or “Operator”; the information is 

particularly useful in the All list where both customers and 

operators are listed.  

Status What the customer is currently doing, for example “Queue” 

or “Talking”. 

Proactive Whether the customer has automatically been invited to 

chat with an operator. 

Campaign The campaign that the customer called from. 

Department The department that is being contacted or that has 

answered to call. 

New Whether this customer is a first time caller; can be “Yes” or 

“No”. 

Page title The title of the Web page that the call came from. 

URL The address of the Web page that the call came from. 

 

The Departments list displays the departments where operators are currently 

logged in while the Operators list display the names of the operators that are 

currently logged in. The two lists basically have the same information but present the 

information from different points of view. 

The final list, the All list, displays all currently active users, both operators and 

customers. The types of information are the same as in the Queue and the All 

Customers lists. 

Note You can customize the information you see in the queue. See section 5.4  

for information about changing the queue. 
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3.2 Chat area 

When you click a customer information line in the queue list, you answer the call and 

can begin chatting with the customer in the chat area: 

 

You type your message in the message area and 

view the chat conversation – both your messages 

and the customer’s replies – in the chat area. 

Use the formatting buttons under the chat area to 

format your text. 

Depending on the way your system administrator 

has configured your interface, a number of tools 

like for example predefined text and predefined 

links are available to make your chat conversation 

easier. See section 3.3 for more details. 

If you want to use audio and video instead of text 

chat, you can turn on your microphone and your 

camera from the Operator menu. See section 3 for 

more details.  

You can chat with several customers at a time 

using the C1, C2, C3 etc. tabs to switch between 

them.  

If a customer asks a question that you do not readily know the answer to, you can 

switch to Chat room and ask your colleagues for information. Chat room is a chat 

area that is common to all operators and visible to operators only. 

If one of your colleagues is better able to assist the customer, you can transfer the 

call by clicking Customer and then Transfer customer. 

In case a customer is offensive or otherwise behaves inappropriately, you can 

prevent the customer from being accepted on the Queue list again by clicking 

Customer and then Ban IP or Ban Computer. The latter option places a cookie on 

the customer’s computer that identifies it whereas Ban IP uses the computer’s logical 

address. You can review banned users and remove bans from Settings. See section 

5.5 for more details. 

Click Customer and then Audio Enabled or Video Enabled to allow the customer 

to use one or the other. This could for example be useful to temporarily enable sound 

– maybe to allow the customer to better elaborate on an issue - in a campaign that 

otherwise has been designed to use chat only. 

The chat area includes summary customer information with IP address, geographical 

location and chat duration; if you need detailed customer information you can switch 

to the Customer information tab. See section 3.5 for more details. 

3.3 Tools 

 

The Tools tab includes 

various aids that can make 

your customer communication 

easier.  
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The actual contents of each category on the Tools tab vary since it depends on the 

system administrator’s setup but these are the main categories: 

Canned Messages These are texts that you use very requently so to save you the 

work of typing the same text repeatedly, the text has been 

given a name and defined as a standard text. To use it you 

select the name of the text from a list and it is automatically 

written in the text chat to the customer. 

Example: 

A relevant text for any operator, regardless of department could 

for example be: 

“I’ll have to look up the exact information. Please hold on for 

second.” 

The text might be named “Please wait” and to write the text to 

a customer, you would select the name Please wait from a 

list.  

The system administrator can define as many texts as are 

needed and the texts can be grouped so that you can choose to 

see texts that are relevant to your area only. 

Knowledge Base These a basically the same as canned message only knowledge 

base texts are longer, procedural type texts.  

Example: 

A relevant knowledge base text for an operator in a support 

department could for example be:  

“To request a new feature, please follow this procedure: 

1. Download a feature request form from our Web site. 

2. Fill in the form. 

3. Send the form to us in an email. 

We will get back to you with a response within one workweek.” 

The text might be named: “Feature reguest” and to write the 

entire message to a chat customer, you would select the name 

Feature request from a list.  

Like canned messages, the system administrator can define as 

many texts as are needed and the texts can be grouped so that 

you can choose to see texts that are relevant to your area only. 

Links These are links to Internet sites that you frequently refer 

customers to. The links work like the predefined texts: the 

system administrator defines names and links and you select a 

name to have the entire address automatically added to the 

chat area. 

Push page These are links that you can push to the customer to control 

what he or she sees on the screen: a new window opens in 

front of the Website with the call button and because Live Guide 

is on top of the browser, you can take control and redirect the 

user to a new URL. 
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Forms These are forms that you can ask the customer to fill in to 

collect information in a structured way. For example, if you 

belong to support department, the information could be about 

the date of purchase, the name of the reseller, the serial 

number, and a description of the error situation. Or for 

customer asking for a trial download, you might want to collect 

some information before providing the download link. 

To push a form to the user: 

1. On the Forms tab, double-click the name of the form you 

want to push. 

 

The form is now listed in your chat area by its internal 

name, for example “/form 3”. 

2. In the chat area, click the Send button to push the form.  

 

Though you see the form as “/form 10304”, this is what the 

form might look like to the customer:  
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Depending on the campaign 

settings that your system 

administrator has defined, the 

customer’s input may be sent 

to you in and email or directly 

to the chat area as plain text, 

for example: 

 

3.4 Operator status 

When logged on you default status is Available but you can set it to Busy if you are 

temporarily unable to take customer calls: 

 

When your status is Busy, you will not count as a resource when customer waiting 

time is calculated. 

Note that if all operators set their status to Busy the call button will automatically 

have status offline. 

3.5 View detailed customer information 

If you need more details than is available in the summary customer information in 

the chat area, you can find additional information on the Customer Information 

tab: 

 

Customer Details Customer details include many types of information, among 

them information about previous calls, the operator who 

handled the last call, the campain the customer called on, and 

the customer’s domain and organization. 

The detailed customer information can be used for a number of 

purposes, for example to trace customers that you would like to 

follow up on or to be able to provide better assistance based on 

your increased background knowledge. 

Keywords include information about how the customer landed 

on the page with the call button, for example through keywords 
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from a search engine like Google. 

The information can be exported and also sent to an email 

address. This can be useful for subsequent follow-up on the 

customer, for example a reminder to contact the customer 

later. 

Chat History The Chat history tab shows all previous contacts with the 

customer, including any notes you or another operator may 

have made as well as the reason the customer called 

(Category). 

The information can be exported and also sent to an email 

address. Like for the customer details described above, this can 

be useful for subsequent follow-up on the customer. 

Notes Notes that you or another operator made for previous calls as 

well as a text edit area that allows you to make notes to the 

current call. 

The information can be exported and also sent to an email 

address as an indication that follow-up on the customer is 

needed. 

Categories Categories are used to indicate the topic of a customer call and 

can later be used to generate statistics. For example, for 

operators from the support department, categories could be 

product names; for operators from a sales department, the 

category could also be product names or it could be “demo”, 

“existing customer”, or “potential customer”.  

The system administrator may set up the system so that it is 

mandatory to select a category before a call can be properly 

ended. If this is that case, you must select one of the 

categories from the list before your status changes to available.  

4 Use logged data 

In your everyday work you will typically use the tools and features described in the 

section above. However, occasionally you may need to review past customer calls or 

generate call reports. To do this you can click the History button and switch from 

real-time view to historical view: 

 

In the history module you can view logged data, use filter criteria and export to a file 

or send to an email recipient. 

4.1 Use filters to get the report you need 

When you click the History button, information about all calls recorded by the 

system is displayed in a list format. You can browse through the list and for the 

current conversation see the chat log and any notes made by the operator. 

Typically though you will likely want to filter the information to limit the data you see. 

You can do this by filtering on: 

 A specific session. 

 Sessions within a date range. 

 Sessions handled by a specific department. 

 Sessions from a specific category. 
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 Sessions that include specific keywords 

The filter criteria can also be used in combination. 

Select the filter criteria you want to use in the Range section and click Filter to 

apply them to the list: 

 

4.2 Export report data 

When you have generated a filtered report, you can export it to an external file for 

further processing. 

 Click the Export as button to select a file format, and then click the Export 

button. 

 

If you selected Csv File (Excel), the file opens in Microsoft Office Excel and it you 

selected Text File, it opens in Notepad. From either of these programs, you can then 

choose to save the file locally. 

4.3 Send logged data to an email recipient 

Instead of exporting to a file, you can also choose to send the report to an email 

recipient. 

 Type the recipients email address and click Send. 

 

The reported data is pasted as text into the email. 
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5 Customize how Live Guide operator console works 

You can customize how Live Guide operator console works within these areas: 

 Your account. 

 When you receive alerts. 

 Layout of the chat area and the queue. 

 Fields and colors in the queue and fields in the video area. 

 Font size and text color in the chat window and in the queue. 

 Restrict customer access. 

Any changes to how the operator console work is done by clicking the Settings 

button: 

 

5.1 Change your account settings 

When you first log on to Live Guide operator console, you do so with an email and a 

password and you will typically be requested to change your password on your first 

logon.  

If you later want to change your password, you 

can do so from the Account tab. 

Display Name is the name that the customer 

sees in a chat conversation. You can also 

change this here. 

 

5.2 Change settings for how you want to be alerted 

You can use the Alerts tab to define whether you want to be alerted with a sound, 

by a text change in the title of the current page, or by a combination of the two. 

 

 Select an event in the list, then select how to 

be alerted, and click Save. 

5.3 Change the layout of the chat area and the queue 

By default the operator console reserves a large part 

of the available screen real estate for the chat window 

since this is where you will interact with customers. 

If you have added customer information columns that 

are essential to your work to the queue, you may 

want to have a larger queue area at the expense of 

the chat window.  

This can be changed from the Layout tab: Click 

Large queue panel to change the default. 
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5.4 Change the queue and the video area 

The comprehensive data that Live Guide collects on all customers is available from 

the Customer information tab when a call is in active. Some of this information is 

also available in the queue but if other fields would be more useful to you, you can 

set up your queue list differently:  

 Select fields from the Available fields list using the Add/Remove buttons 

between the two lists.  

 Sort the files in the Selected fields list using the Move up/down buttons to the 

right of the list. 

Click Save to make your changes permanent; you can always switch between Calls 

and Settings to review the effect of your changes. 

 

The video area is the area above the chat area. When 

neither you nor the customer is using video, the area 

shows your picture or a standard picture. 

Next to the video or the picture four information fields 

are available.  

If you would like different information fields in the 

video area, select from the Available fields list. 

Note that the limited space available means that you 

can select a maximum of four fields. 

 

 

5.5 Change font size and text color 

Use the Fonts tab to make the chat window and the queue panel match your reading 

needs. 

For the chat window you can increase the font size and choose a different color for 

each type of text that can appear in the chat window. This can make it easier to 

distinguish between the texts a customer types and your own texts. 

For the queue you can choose different colors for different states. This can make it 

easier to distinguish, for example, waiting customers and available operators. 

5.6 Ban customer 

When you are working in the operator console online environment, you might 

occasionally ban a customer who behaves inappropriately. As mentioned in section 

3.2 you can do this from the chat area while online with the customer. 

You can use the Banned Customers tab to see a complete list of customers who 

cannot currently contact any operator console operators. If the operator who 

imposed the ban added comments, the list will also list the reason for the ban. 

To remove a ban: 

 Select a row in the banned customers list and click the Remove button. 

You can also ban a customer from the Banned Customers tab. 

To ban a customer: 

1. Type the computer name or the IP address that you want to ban. 

Any bans you set here are effective from subsequent calls; a ban that you set 

from the Options button in the chat area is effective instantly. 

2. Type a reason why you want to ban the customer and click the Save button. 

The new ban is added to the list of banned customers. 


